


Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>
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How to contact us:
By E-mail: mguesdo@worldnet.fr (Prefered)

mguesdon@kagi.com
73373.1446@compuserve.com

WWW: http://www.worldnet.fr/~mguesdo/SBDev_WLT.html
By Fax: (33-1) 42.41.27.27
By Snail-mail: SOFTWARE BUILDERS

89, Av. SECRETAN
75019    PARIS
France

Disclaimers:
Software Builders assumes no liability for damages, including, but not limited to, any lost profits, 

lost moneys, incidental or consequential damages arising out of the use or inability to use this program.
AppTranslator® is provided "AS IS". Software Builders disclaims all warranties, either expressed 

or implied, including, but not limited to, the warranties of merchantability and of fitness for any purpose.
In no event shall Software Builders's total liability to you for all damages, losses, and causes of 

action (whether in contract, tort, including negligence, or otherwise) exceed the amount paid for the 
AppTranslator® Software and its documentation.

Information in this document is subject to change without notice. Companies, names, and data 
used in examples herein are fictitious unless otherwise noted.

License and Legal Information:
. Windows is a registered trademark of Microsoft Corporation.
. The AppTranslator® Software for Windows was written by Manuel Guesdon from Software 

Builders. The AppTranslator® Software and documentation are Copyright 1995-1996 by SOFTWARE 



BUILDERS, with all rights reserved. You can't redistribuate it with your 'registration string' and you're not 
allowed to communicate you 'registration string' to a third party. Reception of 'registration string' is under 
your own responsability (but you can send me your PGP public Key when registering and I'll send your 
'registration string' encrypted).

. This software can't be used by laboratories in biology domain, nor by manufacturers or 
distributors of biology equipment.

Remerciements/Acknoledgments:
I thank Bruno d'Andrea from Executive Partners Software for his help in testing AppTranslator® 

and reviewing documentation. He makes really good products for Windows (including TimeWizard® 95). 
You can reach him at 100430.1650@compuserve.com.

Toute ma gratitude va de même aux personnes qui m'ont soutenues à coup de 'Eh alors, ton soft 
sur Internet, tu le met quand ?'; ce à quoi j'ai répondu, pendant plusieurs mois: 'bientôt, bientôt, j'ai 
quasiment fini: encore 2 ou 3 bugs à corriger...'



Important notes, limitations...

Demo version generates 'DEMO VERSION !!!' translations when there are more than 2 items in a
dialog box, in a menu or in a string table segment (this limitation will disappear when you enter the 
registration string)

String named items can't be imported (Only Numeric IDs can be imported)

Menu are imported by positions

AppTranslator® works only with 16 Bits .RES Files (32 Bits version available soon) Next versions

Dialog Box Items must have a unique Id in the parent dialog box

Partial VBX Support



Bug Report

If you experiment something you think might be a bug in this software, please report it by sending a 
message to mguesdo@world-net.sct.fr
( Best way is doing File\Create New Bug Report, add your comments and do File\ Send As Mail)

Describe what you did, what happened, which version of the software you have, any error messages the 
software gave (the numbers in begining of the messages are especially important), which operating 
system you're using, and anything else you think might be relevant.

Please leave File\Setup\general\Log checked, so we'll have more informations about your problem.



Next Versions...

Will work on 16 & 32 Bits
Will support Fonts informations



Menus

File Menu
Edit Menu
Description Menu
Actions Menu
View Menu
Help Menu



File Menu

The File Menu offers the following commands:

New Create new document.
Open Open document.
Close Close active document.
Save Save active document.
Save As... Save active document with a new name.
Bug Report Create a new Bug Report Document
Register Enter Registration String
Setup Setup.
Send As Mail Send active document as mail.
Exit Exit



File\Setup Option

Software Setup Dialog Box

....



File\Setup\General



Check this if you want to log you actions (this help us in case of bugs)



log file path



Call an Open file Dialog Box to select log file path



Check this if you want 'splash screen' on start up
(for non-registred version, you can't disable this feature)



VBXs Description file path



Call an Open file Dialog Box to select VBXs Description file path



File\Setup\Languages

Here you can parameter defaults values for languages (in a document, you can change them with 
Desciption\Languages



File\Setup\Sound Events



Events Names



Associated Sounds



File\Register Option

When you get register string, this is in this dialog box you can enter your registration string to enable full 
fonctionalities of AppTranslator® (see How to Register ?)



Enter registration string here !



File\New Bug Report Option

Create a new Bug report document
After entering information, you can do File\ Send As Mail



Application Description



Log Report



Your comments



File\Send As Mail Option

Send a document by mail



File\Exit

Exit AppTranslator



Edit Menu

The Edit Menu offers the following commands:

Cut Deletes data from the document and moves it to the clipboard.
Copy Copies data from the document to the clipboard.
Paste Pastes data from the clipboard into the document.



Description Menu

The Description Menu offers the following command:

Languages



Description\Languages Option

Here you can parameter values for languages
Enter your native language followed by foreign languages in this tables. Don't forget to adjust the number 
of languages used at the bottom of the table.



Native language



Languages for translations



Actions Menu

The Actions Menu offers the following commands:

ASCII Out... Export active document Items to an ascii file
ASCII In... Import Items to active document from an ascii file
Add/Merge From Base .RES... Import .RES file items to active document
Generate translated .RES... Export active document items to a .RES file
Verify .RES... Read and verify a .RES File
Read & Write .RES... Read And Write a .RES file
Delete Versions... Delete old versions of items



Actions\ASCII Out

Export last versions to an ascii file (séparator=;). You can use it with Excel...



Actions\ASCII In

Import from an ascii file (séparator=;).



Actions\Add/Merge From .Res

Add .RES file items to the document



.RES source file path



Call an Open file Dialog Box to select .RES source file path



Language to which import the .RES file
(select your native language if the .RES file come from your application or another language if the .RES 
file is a translation)



Import only Items Positions (not texts)
With this option, after generate a translated .RES file and modify positions, you can import position in last 
versions of the choosen language



Actions\Generate Translated .Res

Generate the translated .RES File



.RES source file path (the native .RES file you use for Add/Merge from .RES file)



Call an Open file Dialog Box to select .RES source file path



Language for which you want to generate the .res file



.RES destination file path



Call an Save file as Dialog Box to select .RES destination file path



Check this if you want to update the version info of the generated .res file acoording to generated 
language id
Language Identificator is stored in Version Info Id 1 at \VarFileInfo\Translation 



Actions\Generate Translated .Res\List Button

This enable you to merge others .res files to your generated .res file



This part act as the open file standard dialog box except that you can select multiple files (to drag& drop)



Add selected File to choosen files list



Add All selected Files to choosen files list



Delete selected choosen file



Delete all selected choosen files



Choosen files list



Actions\Verify .Res

Enable you to test a .RES file before importing it



Actions\Read & Write .Res

Enable you to test a .RES file before importing it



Actions\Delete Versions...

Delete old versions



Number of Last Base Versions you want to keep



Increment/Decrement the number of Last Base Versions you want to keep



Number of last versions you want to keep for each Last base versions



Increment/Decrement the number of last versions you want to keep for each Last base versions



Number of last versions you want to keep for Last base version



Increment/Decrement the number of last versions you want to keep for Last base version



View Menu

The View Menu offers the following commands:

Toolbar Shows or hides the toolbar.
Status Bar Shows or hides the status bar.
Summary View Shows the main (summary) view of the active document
Hierarchical View Shows the hierchical view of the active document



Tool Bar



Create a New document



Open a document



Save active document



Edit\Cut



Edit\Copy



Edit\Paste



Print active view



Call help



Activate help mode (after this, click on an item)



Status Bar

For lenghy operations, message part of status bar become a progress indicator



Message



Progress indicator



Insert/Overwrite mode indicator (blank=insert, OVR=Overwrite)



NumLock Indicator



Uppercase Lock Indicator



Document Main View

Document Main View display a summary of the document



Document Hierarchical View

Document Hierarchical View display documents items and allow modifications on these items







Untranslated item for this language are in red, others items are in black



Documents Items Category And Documents Items (click on the left symbol of a category to see items)



Documents Items : Menus (click on left symbols to see items)



Documents Items : Dialog Boxes (click on left symbols to see dialogs controls)



Documents Items : Strings



Dialog Items



Selected Item Description



Native Language Versions for the selected item



Others Languages Versions



Selected Item Status



Selected Item Id



Selected Item Creation and Last modification dates



Native Language Version Description for the selected version of the selected item



Native Language Version Text for the selected version of the selected item



Native Language Version position for the selected version of the selected item



French version description for the selected version of the selected item



French version Status for the selected version of the selected item



French version text for the selected version of the selected item



French version position for the selected version of the selected item



Click this button to modify French version text for the selected version of the selected item



Item Text Modify (Translate)

Modify (translate) the text of an item



Native language Text



Translated Text



Windows Menu

The Windows Menu offers the following commands:

Cascade Cascade
Tile Tile
Arrange Icons Arrange Icons



Errors



Help Menu

The Help Menu offers the following commands:

Index Offers you an index to topics on which you can get help.
Using Help Provides general instructions on using help.
About Displays the version number of this application.



Help\Index

Index of the help



Help\Using Help

How to use help



Help\About AppTranslator®...

Informations about AppTranslator®



Help\How to contact us

Informations on how to contact us



With this button, you can copy 'how to contact us' informations to the clipboard



What Is AppTranslator® For ? 

AppTranslator® helps you to translate your Windows Application into foreign languages.
All you have to do is importing your application native language .RES file, translate items (menus,

strings, dialog boxes and dialog controls) and ask AppTranslator® to generate a new .RES file.

See Main Steps



Main Steps 

1) Create a new document.

2) Enter your native and foreign languages in the 'Languages' item
from 'Description' menu. (Enter Native Language First)

3) Import your Application's Native Language .RES file with Actions\Add/Merge From 
Base .RES...

4) Display the Hierachical view with View\Hierarchical View

5) Translate items

6) Export your translation into a new .RES with Actions\Generate translated .RES...

7) Link this new .RES with you project (or within a DLL)



VBX Support

The ability to use VBX controls depends on the control properties organisation (i.e. can all the 
properties be described before caption)

To support VBX, you have to fill a section manually in the VBX Description file path for each VBX 
you use.
If you use AppStudio, Best way of doing this is to copy AppStudio.Ini VBX Section and add Lines 
PropSize... for each properties.

Example:

[VBX:SPIN.VBX;SpinButton]
PropSize1=S ;CtlName
PropSize2=2 ;Index
PropSize3=N ;Left
PropSize7=1 ;Enabled
PropSize8=1 ;Visible
PropSize10=2 ;hWnd
PropSize13=1 ;Tag
PropSize14=4 ;BackColor
PropSize15=4 ;ForeColor
PropSize17=4 ;LightColor
PropSize18=4 ;ShadeColor
PropSize20=4 ;BorderColor

PropSize23=4 ;ShadowForeColor
PropSize24=4 ;ShadowBackColor
PropSize26=4 ;SpinForeColor
PropSize27=4 ;SpinBackColor

Codes signification:
S means property is a string (control name...)
1,2,3,4 is the size used to save the property (4 for color,2 for index, HWnd,1 for flags...)
N means AppTranslator® won't load this property nor the ones following (used for 

Left...)

A sample file is included in this package: vbxes.ini



How to use a dll for res ? 

You can use ResDll project wich is included in this package:
just build it and, after, link your generated .res file to it.

In your application, you have to write something like that:

// Try to load the library
HINSTANCE hLangDll_HInstance=LoadLibrary(szDLLPathName);

// Verify it's OK
ASSERT(((UINT) hLangDll_HInstance)>=32);
if (((UINT) hLangDll_HInstance)<32) // Error
{

hLangDll_HInstance=0;
}
else
{

// If you want VBX support: {
// Call the RegisterVBX function of the DLL
typedef BOOL (__far *          TlpfnRegisterVBX)(HINSTANCE);
TlpfnRegisterVBX lpfnRegisterVBX=NULL;
FARPROC lpfnRegisterVBX_Temp;
lpfnRegisterVBX_Temp=GetProcAddress(hLangDll_HInstance, "RegisterVBX");
lpfnRegisterVBX=(TlpfnRegisterVBX)lpfnRegisterVBX_Temp;
BOOL fOk=(lpfnRegisterVBX!=NULL);
if (fOk)

fOk=(*lpfnRegisterVBX)(AfxGetInstanceHandle());
if (!fOk) // Problem
{

FreeLibrary(m_hLangDll_HInstance); // Unload Library
hLangDll_HInstance=0;

};
// } End of VBX Support Part

};

if (hLangDll_HInstance) // OK
{

// new Ressource hInstance is hLangDll_HInstance
AfxSetResourceHandle(m_hLangDll_HInstance);

}
else // Problem
{
// Ressource hInstance is App Instance

AfxSetResourceHandle(AfxGetInstanceHandle());
};



How to Register AppTranslator® ?

Important: by registering, you accept all licence terms (see License and Legal Information ).

Registration methods:
. CompuServe Registration:
To have the registration fee added to your CompuServe bill use the CompuServe command GO 

SWREG and follow the menus.
AppTranslator® 's registration ID is 11578.

. Other payment methods (credit card, check...):
Run register.exe and follow recommendations.

When you register: you will be sent a registration key that removes translated items number limitations. 
You will also be informed of newer versions as well as our upcoming exciting products.

Comments are welcome.
Thank you for your support.



Order Form

To print this form, click on Print Topic in the File pull-down menu.

Fill and send this form to us by mail (see our address in this Help file Contents ) with your payment:

I want to register _____ copies of AppTranslator® at US $_______ each = total US $_________
or

I want to register _____ copies of AppTranslator® at _______ FRF each = total _________ FRF

Name : __________________________________________
Company : __________________________________________
Address : __________________________________________
City : __________________________________________

State : __________________________________________
ZIP : __________________________________________
Country : __________________________________________
Phone : __________________________________________
Fax : __________________________________________
E-Mail : __________________________________________

Comments about AppTranslator® :
________________________________________________________
________________________________________________________
________________________________________________________

______________________________________________________________________________
Copies Number US $ Unit Price FRF Unit Price
______________________________________________________________________________
1-3 99 549
4-9 79 449
10-19 69 389
20-29 59 329
30- and more 44 249
Unlimited Licence for a single company 2000 11000
_____________________________________________________________________________
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